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Generating Radar Waveforms with an Arbitrary Waveform Generator

FROM THIS APPLICATION NOTE, YOU WILL LEARN:
• Why AWGs are ideal for generating radar test signals
• How to generate radar waveforms with Tektronix
equipment
• Recommended configurations for radar testing
• Features of Tektronix equipment to ease radar test
signal generation

• Receiver systems including downconverters, filters,
preamplifiers, IF (intermediate frequency) amplifiers, AGC
(automatic gain control), and signal digitization
• Radar signal demodulation systems
• Power amplifiers and associated filters
• T/R (Transmit/Receive) switches
• Transmission line and slipring systems

This application note uses a Tektronix AWG70000B Arbitrary

• Antennas

Waveform Generator with software plug-ins to create

• Generating interference for testing system performance

a range of RF test signals. The methods discussed here are
in general applicable to other Tektronix Arbitrary Waveform

Several different types of signals are required at different

Generators.

points to test these systems and subsystems. Tektronix AWG
instruments can be used to provide many types of useful test
signals.

This application note shows how Tektronix software is used
with an Arbitrary Waveform Generator (AWG) to create a wide

• Pulsed and modulated radar signals at the operating
frequency

range of RF and baseband signals for the characterization and

• Pulsed and modulated radar signals at IF frequencies

test of radar systems and subsystems. Radar is widely used to
sense objects using radio frequency signals in a wide range of
commercial, military, and government applications. Automotive
radar allows cars to determine the distance and rate of closure
to other objects, military and commercial avionics radar allows
aircraft to determine their altitude and the location and velocity
of aircraft and missiles, and weather radar can determine the
location of storms, the relative content of hail and rain, and the
velocity of tornadic winds.
AWG instruments are widely used to generate radar test
signals because wideband test signals are needed to check
the proper operation of radar amplifiers, antennas, receivers,

• IQ (In-phase and Quadrature) baseband modulated radar
signals
• Shaped analog baseband pulses with controlled rise and
fall envelopes
• Fast digital pulses synchronized with the analog signals
described above for gating, switching, and output
amplifier bias control
• Slower digital control signals useful for controlling
subsystems, such as frequency, attenuation, and antenna
polarity switching
RECOMMENDED HARDWARE

and other subsystems. Many radar systems use very wide

The AWG models recommended for generating radar

bandwidths and complex modulation which cannot be

signals are:

simulated by modulated analog RF signal generators. Many
tests on radar systems require precise timing in the low
nanosecond range which can only be generated using an AWG
with low jitter triggering and marker timing outputs.
For creating waveforms to be output, software tools are
needed. Modern software tools like an AWG's controlling UI or
Tektronix’s SourceXpress offer advanced features to simplify
the process of creating waveforms to be output by an AWG.
The waveforms and sequences created can be used for test
and verification of the characteristics of radar systems and
subsystems such as:
• Transmitter systems including upconverters, filters, and
power amplifiers

• AWG70001B (one analog output channel at up to a
20 GHz signal frequency)
o Option AC (+18 dBm output amplifier, high-range step 		
attenuator, and anti-aliasing filters)
• AWG70002B (two analog output channels at up to a
10 GHz signal frequency)
• AWGSYNC01 (synchronization hub which allows from
two to four AWG70001B or AWG70002B instruments to
be tightly synchronized, useful for generation of up to
four 20 GHz signals or up to eight 10 GHz signals)
• AWG5202 (two analog output channels at up to a 2 GHz
signal frequency)
• AWG5204 (four analog output channels at up to a 2 GHz
signal frequency)
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• AWG5208 (eight analog output channels at up to a 2 GHz
signal frequency)

filters are available to reduce DAC aliasing and other spurious
outputs.

In some cases, one AWG is sufficient to test a subsystem. For

The AWG70000B Series uses two 10-bit DACs, while the

example, a single channel high speed AWG could be used to

AWG5200 series uses two, four, or eight 16-bit DACs. The

generate a single 10 GHz fully-modulated radar signal, a high-

triggering and sequencing details are also a bit different on

speed digital control signal to provide fast bias control of the

the AWG70000B series and AWG5200 series instruments. The

output amplifier, and several lower-speed digital control signals

AWG70000B series provides much tighter timing of waveforms

which are needed for a test. A two-channel AWG instrument

and marker signals and is to be preferred for most radar signal

can provide IQ baseband or low IF frequency signals as well as

generation.

digital control signals. In other cases, it might be necessary to
tightly synchronize multiple AWG instruments so that multiple

RECOMMENDED SOFTWARE

signals at the same or different frequencies with controlled

Several pieces of software are mentioned throughout this

phase characteristics can be used for an advanced system

application note and can be used to for creating and editing

test. Tektronix offers a synchronization hub which can lock up

RF waveforms. The first is the UI software of the AWG

to four AWG70000 series instruments together with very low

itself. The next is SourceXpress, optional software that only

jitter and provide tightly aligned waveforms at the end of test

runs on an external PC but looks similar to the AWG UI.

cables using a calibration procedure.

SourceXpress is available as a free download from www.tek.

A wideband AWG consists of a high-speed digital memory,
control circuits, sampling clock, high-speed digital to analog
converter (DAC), and in some cases output amplifiers,
attenuators, and filters. This design architecture allows very
wideband signals to be generated. For example, a pulsed

com/sourcexpress. Finally there are software plug-ins that can
run on both SourceXpress and the AWG UI. Plug-ins enhance
the capabilities of both SourceXpress and the AWG UI to allow
the simple creation of more complex waveforms for specialty
applications, like radar signal generation.

signal with a linear FM chirp starting at 10 GHz and ending at

Most settings in the software plug-ins can be seen before an

15 GHz can be created, and a pre-compensation procedure

enabling license is installed, but without a valid plug-in license

can be used to flatten the signal at the end of a test cable

installed on that PC or instrument you will see a warning

due to cable loss and sin(x)/x effects. Multiple signals can be

message near the top (directly below the Plug-in: selector).

superimposed on each other using one AWG, so it is possible
to simulate multiple 4G and 5G transmitters and wideband

Licenses for plug-ins are installed using the Tools menu at the
top of the screen.

noise as well as the desired radar test signal. A multi-channel
test can be performed by using one or more single or multichannel tightly synchronized AWG instruments. This could
allow generation of a multi-channel test signal with stationary
background interfering signals on each channel and a nonstationary moving signal simulated by amplitude and phase
changes to one signal frequency component across the
channels.
Tests on power amplifiers, high-level mixers, filters, and
antennas can require more power than the DAC output can
produce. Tests on receivers and IF amplifiers may need

Figure 1: Plug-ins warning if not licensed.

low test signal levels. For the single-channel AWG70001B
instrument, Option AC is available to provide a much wider

The following software plug-ins are very useful for testing radar

range of test signal powers. Output power of over +18 dBm

systems and components:

in some cases is available, as well as a high-range step
attenuator for generating low output power levels. Several
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• The Radar plug-in assists you in creating a wide range of
radar signals based on signal parameters such as pulse
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width, envelope shape, pulse repetition interval (PRI),
modulation type, staggered PRI, and other details. This
application note describes the basic use of this plug-in
for generating several types of pulsed radar waveforms.
• The S-parameter plug-in allows the use of imported
user S-parameter files to embed or de-embed known
cable losses, test fixtures, and filters. For example,
you can test an IF amplifier and receiver subsystem by
generating waveforms simulating the effect on various
radar signals due to the frequency response of IF
amplifier filters which have not yet been constructed. Or
you could use a VNA to measure the in-band passband
ripple of an adjacent band protection filter situated at the
output of a high-power amplifier, and separately measure
a test cable connecting the AWG to the power amplifier.
You can then de-embed both S-parameter responses
from a wideband LFM chirp generated by an AWG to
generate a high-power signal with flat response over the
chirp bandwidth.
• The Pre-compensation plug-in can be used with an
AWG and a wideband oscilloscope to very accurately
flatten the output frequency response due to AWG
sin(x)/x and output hardware roll off, connectors, and test
cables. SourceXpress controls both the AWG and the
oscilloscope to automatically create a system correction
S-parameter file which can easily be applied to any
waveform, including imported user waveforms.
• The Environment plug-in builds waveforms simulating
real-world conditions within a complex RF environment
which can interfere with radar system performance. For
example, you could simulate the superposition of two
radar signals at overlapping frequencies, an adjacent
channel WiFi or cellular signal, four CW signals, and
band limited AWGN noise. The frequency and amplitude
of each of these signals can be changed. The software
creates each signal at IQ baseband, upconverts each of
them to the desired frequencies, then combines them
at the desired amplitudes to create one resulting test
signal. The parameters used to create the combined RF
environment are saved, so you can recall this setup later,
change the characteristics of one signal, and recompile
a new test signal. The Environment plug-in can use
the radar and other plug-ins and use user-provided
baseband IQ waveforms.

• Radar plug-in (RADARNL-SS01 or RADARFL-SS01
license) – described in detail in this application note
• S-Parameter plug-in (SPARANL-SS01 or SPARAFL-SS01
license)
• Environment plug-in (ENVNL-SS01 or ENVFL-SS01
license)
• Pre-compensation plug-in (PRECOMNL-SS01 or
PRECOMFL-SS01 license)
Other plug-ins which generate RF signals are:
• RF Generic plug-in (RFGENNL-SS01 or RFGENFL-SS01
license)
• OFDM plug-in (OFDMNL-SS01 or OFDMFL-SS01 license)
• Multitone & Chirp plug-in (MTONENL-SS01 or
MTONEFL-SS01 license)

Controlling AWG70000 and AWG5200
Instruments
There are two software options for controlling a Tektronix
AWG5200 or AWG70000: The user interface installed on the
AWG itself, or SourceXpress on an external Windows PC. The
AWG UI can only control the single AWG it's installed on while
SourceXpress has more options. When run on a Windows
PC connected via a newtwork to an AWG, SourceXpress
allows you to create and compile waveforms on your PC, then
immediately upload and output them on the AWG. When used
offline, SourceXpress allows you to emulate instruments and
save software settings, compiled waveforms, and sequencer
tables in .awgx setup files. These files can then be moved to
the AWG which will be used to generate the signals.
You can control your AWG in four different ways:
1. Using the AWG user interface (see Figure 2 - AWG local
use model)
o The user interface built into the AWG5200 and
AWG70000 looks and feels much like SourceXpress,
though it is distinct software. First install the

Plug-ins, whether being used with SourceXpress or the AWG
UI, require licenses to be installed to generate signals. A single
license cannot be used by both the AWG UI and SourceXpress
at the same time. All these plug-ins are available in either Node
Locked (NL) or Floating (FL) versions. Visit
www.tek.com/products/product-license for the most current
descriptions of Tektronix product licenses. The most important

Figure 2: AWG local use model.

plug-ins for radar applications are:
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APPLICATION NOTE

Generating Radar Waveforms with an Arbitrary Waveform Generator

appropriate licenses (such as the radar and other plugins) on the AWG, since that is where the signals will be
developed.
o This is the only use case that requires any plug-in
licenses to be installed on the AWG. For all other
use cases, any licenses should be installed on the
controlling PC.

into the AWG to transfer the waveforms and sequences
to the AWG. The DVD can then be destroyed for
security reasons.
o The PC and AWG can be at different locations with no
interconnections.
3. Use SourceXpress installed on a user PC connected to
the AWG (see Figure 4 - Connected remote use model)

o You can then use the features described in this
application note to compile radar waveforms and
sequences directly on the AWG instrument and store
them on the instrument SSD (solid state disk drive).
o At run time, the waveforms and sequences are
transferred from the AWG SSD to high-speed memory
for use by the DAC to generate the analog waveforms,
markers, and flags.
o If waveforms are created on one AWG in this manner,
they can be transferred manually to other AWG
instruments (of that same model) using a LAN, USB
memory stick, or DVD drives connected to each AWG
instrument. The Radar plug-in license must be installed
on the one AWG which is used to develop and compile
the waveforms. No licenses for plug-ins need to be
installed on an AWG to play a compiled waveform.
2. Use SourceXpress installed on an isolated user PC (see
Figure 3 - Independent PC remote use model).

Figure 4: Connected remote use model.

o Install SourceXpress and the appropriate licenses onto
your PC.
o The PC must be connected using a LAN to the AWG.
Routers must allow the passage of certain packet
types and port numbers for this feature to work
properly.

Figure 3: Independent PC remote use model.

o Install SourceXpress and the appropriate licenses onto
your PC.
o You can then use the features described in this
application note to design radar signals. Then compile
them into waveforms and sequences which are saved
onto the PC disk drive.
o Compiled waveforms and sequences can be
transferred from that PC to one or more AWG
instruments using manual Windows networking
features or a USB stick.
o If site security rules do not permit use of networking
or USB RAM storage devices, you can write the
waveforms and sequences to a DVD using an internal
or external DVD disk drive on the PC, close the DVD so
it cannot be edited, scan the DVD at a security control
office for viruses, then use a USB DVD drive plugged
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o You can then use the features described in this
application note to design radar signals. When the
signal is compiled, the compiled waveform and
sequence files will be automatically transferred over the
LAN and saved on the SSD in the AWG.
o The experience is similar to running the Radar plug-in
inside the AWG, but due to differences between the
computing platforms this is a better use model for long
and complex radar signals. It also allows you to be in
an office environment designing radar signals while the
AWG is in a remote lab. This feature has been verified
to work between buildings in a campus.
4. Use SourceXpress installed on a user PC connected to
an AWGSYNC01 synchronization hub (see Figure 5 Synchronization hub use model)
o Install SourceXpress and the appropriate licenses onto
your PC.
o The PC must be connected using a LAN to the
AWGSYNC01 hub. Routers must allow the passage of
certain packet types and port numbers for this feature
to work properly.
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o You can then use the features described in this
application note to design radar signals. When the
signal is compiled, the compiled waveform and
sequence files will be automatically transferred over
the LAN and saved on the SSD in the correct AWG
instruments.

o To create a gang in a live connected setup (where the
PC is connected over a LAN to the AWG instruments),
multi-select the member AWG instruments and rightselect using the mouse, then choose 'Create Gang.'
You can only create a gang if the instruments are of the
same model.

o The hub is connected to 2, 3, or 4 identical
AWG70000A/B series instruments using custom RF
and data cables which are supplied with the hub. You
can treat the multiple AWG instruments as an AWG
gang as shown in Figure 6 so they appear to act as a
multichannel instrument in SourceXpress.

o The AWGSYNC01 hub includes four front panel
calibration ports with an automatic deskew feature.
The single high-speed clock for all instruments is
supplied either by one of the instruments or an external
golden low jitter microwave clock between 6.25 and
12.5 GHz. The AWGSYNC01 distributes this clock
and triggering signals cleanly to all instruments. This
use model allows tightly synchronized and deskewed
radar signals with low jitter to be generated on up to
4 channels using AWG70001B instruments or up to 8
channels using AWG70002B instruments.

o To create a gang in a virtual setup (where the PC is
not connected to the AWG instruments), first create
multiple instances of appropriate virtual instruments
and name them as desired. Multi-select the member
AWG virtual instruments and right-select using the
mouse, then choose 'Create Gang.' You can only
create a Gang if the virtual instruments are of the
same model.

Radar Plug-in
SourceXpress
User PC
AWGSYNC01
Synchronization
Hub

AWG1

AWG2

AWG3

AWG4

Figure 5: Synchronization hub use model

Figure 6: AWG gang setup.

WWW.TEK.COM | 7

APPLICATION NOTE

Generating Radar Waveforms with an Arbitrary Waveform Generator

AWG70000 Series Signal Generation
Hardware Control

waveform sample is read out to the DAC and markers by

The following description is of the AWG70000B series

coupled outputs. The full-scale DAC voltage can be set over

hardware operation. The AWG70001B and AWG70002B

a range of 2:1 (6 dB). Lower amplitude signals can still be

models both have a standard waveform memory length of 2

generated by either instrument model by creating waveforms

GSamples for each channel, which can be upgraded using

which only use the lower significant bits of the DAC. Option

an option key to 32 GSamples on the AWG70001B or 16

AC (described below) provides a much wider range of output

GSamples per channel on the AWG70002B. The memory width

levels maintaining the full dynamic range (up to 10 bits) on

is 10 bits and the digital to analog converter (DAC) also has 10

the AWG70001B single channel model. On the two-channel

bits of resolution. In addition to the DAC for creating an analog

AWG70002B instrument, the analog output maximum DAC

voltage from each waveform memory word, there are two high

level and marker output level can be independently controlled

speed digital marker outputs from the high-speed memory

for each output.

which can be made available for each channel. You have three
choices for mapping the 10-bit memory words to the 10-bit
DAC and two digital marker outputs:

the sampling clock, which increments sequentially through
the memory. Each analog channel is a differential pair of DC

Option AC amplified output is a feature only available for the
AWG70001B model. This adds a single-ended AC coupled
additional front panel output connector. Three power amplifier/

• 10-bit DAC resolution with no markers active

attenuator stages allow the output full-scale power to be set

• 9-bit DAC resolution with 1 marker active

as low as – 90 dBm or as high as +25 dBm (depending on

• 8-bit DAC resolution with 2 markers active

frequency) with 1 dB steps over a range of 10 MHz to 18 GHz.

The digital marker outputs have many uses, including:
• Triggering external test equipment (such as an
oscilloscope) at a precisely controlled time within a
waveform.
• Providing triggering, gating, and clocking signals to the
device under test.

Three anti-aliasing and anti-spur filters are also available. A
microwave relay allows use of either the interleaved differential
DC coupled outputs or the single AC coupled amplified and
attenuated output. These features are all available using
programmatic control.
Streaming ID is an optional feature which controls the
hardware sequencer state using UDP control packets sent

Marker timing resolution is governed by the DAC sampling

from an external user system, allowing your system to

clock. So, if the sampling clock is set to 1 GS/s, the minimum

dynamically control which radar waveform is being generated.

marker width is 1 ns, and possible widths would be 1, 2, 3, 4,

The streaming ID feature includes flow control and status

5, … ns. The marker could generate a square wave clock with

packet support. In addition to the streaming option, a standard

a maximum frequency of 500 MHz with such as sampling clock

parallel 8-bit input port with strobe line feature can be used to

setting. At the maximum sampling clock setting of 25 GS/s for

control the state of the hardware sequencer from an external

each DAC, the marker timing resolution is 1/(25 GS/s) = 40 ps.

system.

The marker rise/fall time is <35 ps, so setting the marker bits
to alternating high and low will produce a 12.5 GHz sine wave
due to the limited rise and fall times.
The AWG70001B has one analog channel (formed by
interleaving two 25 GS/s maximum sampling rate DACs) and
two markers which can be configured as mentioned above.
The AWG70002B has two analog channels (using one DAC
for each channel with a maximum sampling rate option of 8,
16, or 25 GS/s per channel) and four markers (two assigned
to each channel), and you can set the DAC resolution (and
available markers) independently on each channel. Each
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High quality narrowband or wideband radar signals can
be generated using SourceXpress with Tektronix Arbitrary
Waveform Generators. Here are some other AWG70000B
Arbitrary Waveform Generator features and what they provide:
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AWG70000B Feature

Benefit

10-bit high resolution digital to analog converter (DAC)

Low spurious content and high amplitude resolution

Low phase noise wide range internal clock synthesizer

High resolution of distance and velocity in radar system

External golden microwave sampling clock input

State of the art timing and jitter performance

Sampling rates up to 50 GS/s

Generate wideband radar signals up to 20 GHz

1 ps resolution delay adjustment with 400 fs RMS jitter

Very tight timing of markers and analog outputs

Advanced hardware waveform sequencer

Generation of very complex and long pulse sequences

Internal trigger generator with variable timing menu

Quick front panel control of pulse repetition interval

Two external trigger inputs

Advanced synchronization with external equipment

Two high speed digital marker outputs per channel

Triggering and gating external equipment

Four digital flag hardware sequencer outputs per channel

Control of external devices such as bias and PIN switches

Option AC amplifier/attenuator/filter feature

Wide range of test signal powers with low spurious

Internal Windows 10 PC with 6 USB ports and LAN

Stand-alone operation with internal Radar Plug-in

Internal touch screen display

Stand-alone operation without using a mouse

VGA video output

Allows external larger monitor to be used

eSATA disk drive interface

Improved security and use of existing external drives

Front panel replaceable >1 TB SSD solid state drive

Improved security

Front panel trigger buttons (2)

Easy manual control of waveform sequencer

Front panel all outputs OFF button

Easily turn all RF outputs off for safety

Front panel knob and keypad

Easy manual operation

AWGSYNC01 synchronization hub for up to four AWGs

Multichannel phased array radar testing

AWG70000 Series Hardware Sequencer
The hardware waveform Sequencer option feature can repeat
waveforms and create digital output control signals based
on the current sequencer step. One level of sub-sequencing
is also available, which allows several sequencing steps to
be called similar to a software subroutine and looped. Two
external trigger inputs can be used to trigger the sequencer at
a particular step. An 8-bit parallel input with strobe line can

any moment, the AWG is either stopped (and perhaps waiting
for a trigger) or is playing out one waveform by sequentially
reading out the memory samples through the DAC and
markers to the outputs. The base instrument can be set up
to operate in continuous mode (repeating one waveform by
looping), triggered mode (generating one waveform after each
trigger), or continuous triggered mode (starting continuous
looping of one waveform after a trigger).

cause the sequencer to jump to a different step. In addition to

The optional hardware waveform sequencer can dramatically

the two SMA connector front panel marker outputs available

reduce memory requirements and adds many capabilities.

for each channel from the high-speed memory (stolen DAC

In a sequence, the high-speed memory is only used for

bits), four SMB connector rear panel auxiliary outputs are

one instance of each waveform listed in the sequence, no

available for each channel on the rear panel. The auxiliary

matter how many repeats or multiple entries referencing

outputs can be used as digital output flags controlled by the

that waveform are used. For example, consider generating

sequencer. These can be used to trigger external equipment

a radar signal using a single waveform with an AWG70001B

based on the sequencer state. An internal user-adjustable

instrument. If the goal is to generate a 10 GHz pulsed radar

interval timer with a range of 1 µs to 10 seconds can be used

signal with a 1 µs pulse width and 100 µs PRI (Pulse Repetition

to trigger the sequencer and can be routed to an auxiliary

Interval) and the sampling clock is set to 50 GS/s, the

output.

waveform length would be 100 µs and the length in samples of

From a user point of view, the AWG high-speed waveform
memory is split into one or more waveform files. The waveform
names can be set as desired. Many thousands of waveforms
can reside simultaneously in high-speed hardware memory. At

the total required waveform would be:
Ltotal = (100 µs) * (50 GS/s) = 5 M samples
The waveform length of each 1 µs pulse would be:

WWW.TEK.COM | 9
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Lpulse = (1 µs) * (50 GS/s) = 50 K samples
The dead time between pulses has a waveform length of:

The total waveform memory used by the example above is
one copy of each waveform, no matter how many times the
waveform is used in a step or looped. So the total memory

Ldeadtime = (99 µs) * (50 GS/s) = 4.95 M samples

used when employing the sequencer is:

It’s obvious that 99% of the total waveform is dead time (zero

L = (50 K) + (100 K) + (150 K) + (50 K) = 350 K samples

voltage samples). If the hardware sequencer option is installed,
a 1 µs long waveform of zero-volt samples can be used by the
sequencer and looped 99 times to generate the 99 µs dead

If instead we created one flat waveform with no looping, the
memory used would be greater by a factor of about 43:

time. This is much more efficient use of high speed memory.

L = (300 µs) * (50 GS/s) = 15 M samples

You could create a repeating 300 µs long signal consisting

This example also shows control of the rear panel SMB Flag

of the following pulses at a fixed 100 µs PRI at a 50 GS/s

outputs by the sequencer. Flag A is high during the 1 µs wfm1,

sampling rate in the following manner using the following four

flag B is high during the 2 µs wfm2, and flag C is high during

waveforms and the optional hardware sequencer:

the 3 µs wfm3. These flag output signals can be used to trigger

wfm1: 1 µs wide RF pulse (50 K samples)
wfm2: 2 µs wide RF pulse (100 K samples)

external test equipment such as an oscilloscope to verify the
output of a DUT when using only a particular pulse excitation.
In most cases the Radar plug-in can generate either a

wfm3: 3 µs wide RF pulse (150 K samples)

sequence with short deadtime waveforms as shown above, or

dead1: 1 µs wide all zero volts (50 K samples)

use of the sequencer. The sequencer length is up to 16,383

This sequence is shown in Figure 7 as it appears in the
SourceXpress Sequence Editor screen. There are no entries in
the Wait column, so as soon as the instrument is placed into
the Play mode the sequencer will immediately execute step
#1. The table should be read from left to right to understand
how it is executed. The sequencer seamlessly moves between
steps as indicated in the Go to column after playing the Track
1 waveform the number of loops indicated in the Repeat Count
column. Note that after executing step #6, the sequencer
immediately jumps to step #1 without a gap. The Track 1
Flags column indicates how flags are changed for each step.
The Length column shows the length of one iteration of the
waveform before looping.

a single much longer flat waveform file which does not require
steps, and the waveform repeat count range in a step is 1 to
1,048,576. The repeat count can also be set to infinitively loop
a waveform. An event from one of two external trigger inputs or
the internal interval timer can be used to terminate a sequence
step prematurely asynchronously or at the end of a waveform
by jumping to a different sequence step. Two front panel
buttons can generate the trigger A and trigger B events, as
well as two rear panel inputs. A simple example of sequencer
use would be to generate an infinite loop which is interrupted
by the front panel trigger A button. You could use this with the
previous 6-step sequencer table example by adding Event
Input and Event Jump to entries and Go to entries so that
pressing the front panel trigger A button would step between
generating a 1 µs, 2 µs, and 3 µs wide radar pulse.

Figure 7: Sequencer settings for generating mixed pulse width radar signal with 1 µs, 2 µs, and 3 µs wide pulses with
dead time repeated to cause a 100 µs pulse repetition interval.
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One level of subsequencing is available. A subsequence is
a series of sequencer steps which can be inserted into a
main sequence step. Subsequences use redirection to save
sequence memory and improve the ability to easily view and
edit the flow of sequences.
• For example, let’s say that you create a sequence named
Alpha consisting of the 6 sequence steps shown in Figure
7, and you need to use this series of sequence steps in
multiple places in your main sequence. In the Sequence
Editor screen, open File>Rename and set this 6-step
sequence name to Alpha. Then use File>New to start an
empty screen to create your main sequence, which by
default is named “Sequence”.

APPLICATION NOTE

to jump outside the subsequence. The trigger event
related features are restricted to the main sequence step
which is the envelope containing that instance of the
subsequence.
See Using the Sequencer on Tektronix AWG70000B series
instruments for more details about use of the sequencer.

• You can insert sequence Alpha as a subsequence
as step #1 of your main sequence by either doubleclicking the Track 1 field I step 1 and choosing Alpha
under the Sequence tab or by dragging Alpha from the
Sequences window to the Track 1 field of step 1. Now
change the Repeat Count to 100. In the upper right part
of the Sequence Editor screen, you can see that you
have only used 7 steps (1 in the main sequence and 6
in the inserted subsequence) to generate a signal with
300 pulses (100 iterations of the three pulses of different
widths). See Figure 8.
• If you double-click the triangle-shaped icon (indicating
that this step contains a subsequence) adjacent to the
step 1 index, you can open the subsequence, view it,
and edit it. See Figure 9. Any changes you make to the
subsequence will change the original subsequence you
inserted. Use the large X in the upper right to close the
subsequence display.
• Now double-click the Track 1 field of step #2 and insert
waveform dead1 with a Repeat Count of 50,000. Since
dead1 is a 1 µs long zero voltage dead time, this inserts a
50 ms gap in the generated signal. Then insert sequence
Alpha into step #3 of the main sequence with a Repeat
Count of 700. You will now only have used 9 steps (3
main sequence steps and the 6 subsequence steps
inserted twice and repeated a total of 800 loops but
counted only once). See Figure 10.
• Since there is only one hardware instance of a particular
subsequence, if you edit a subsequence inside a main
sequence step you are editing all uses of that particular
subsequence in the sequencer. So if you edit the
subsequence in this example, it will change Alpha in the
Sequences folder and all uses of Alpha in that sequence.
• A subsequence step can only contain a waveform
name, flag settings, repeat count, and Go to (within
the subsequence steps). Within a subsequence you
can not use a wait for trigger, an event jump, or a Go
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Figure 8: Subsequence Alpha with a repeat count of 100 inserted into the main sequence. The icon adjacent to step
number indicates that this step contains a subsequence. Only 7 sequencer steps are used (6 in subsequence Alpha + 1 in
the main sequence).

Figure 9: Opened subsequence showing steps 1.1 ... 1.6. Click large X to close subsequence display.

Figure 10: Steps 1 and 3 are subsequences but step 2 is a normal sequence step. Only 9 sequencer steps are used (6
in subsequence Alpha and 3 normal sequence steps) and 16,374 steps are still available. This sequence will be triggered
from the internal trigger generator due to the Internal entry in the Wait column of step #1. After completing 100 repeats of
the three pulses (100 x 300 µs = 30 ms), a delay (50,000 x 1 µs = 50 ms), and 700 additional repeats of the three pulses
(700 x 300 µs = 210 ms) for a total of 290 ms, the sequence execution jumps back to step #1 and waits for the next
internal trigger to continue.
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SourceXpress Home Tab and Waveform
Display

in the waveform list with a modified name, apply a flatness

The home display of a flat waveform (without using the

modify the waveform (such as by inverting, time reversing,

sequencer) generated by SourceXpress using the radar plugin

changing the amplitude, shifting in time, changing the length,

on a PC with a 9-bit DAC setting (one marker active) is shown

or resampling to a different effective sampling rate).

in Figure 11. The three windows shown at the left side can be
hidden or moved by using the Windows menu at the top of
the screen, by selecting the pin in the upper right of an active
window, or by dragging the window around the screen. The
four buttons in the upper right of the screen can be used to
reset to a default setup, reset the window setup, or read a

correction to the waveform (using a .corr correction file created
by the Pre-Compensation plug-in), modify the marker(s), or

Note that the selected (highlighted) generator to be used is a
virtual AWG70001B. The Virtual Generator can be customized
to match the hardware characteristics of the AWG which will
be used to play back the waveform. Right-click on a Virtual
Generator to rename that generator, set it active, set it to be

version of the user manual for help.

default when the Radar Plug-in is next used, or to remove

In this example, SourceXpress is running as a stand-along

screen is used to create a new Virtual Generator based on the

application on the PC with no connection to an AWG. Note that

target instrument model and options.

the default M1 (marker 1) output signal in this case is a 50%
duty cycle pulse with a rising edge at the start of the waveform
interval. SourceXpress includes tools to change the marker
output signal waveform and timing. One waveform is available
in the SourceXpress waveform list, and it has been named
PulseTrain_1 (by default) by the Radar plug-in. By right-clicking
the PulseTrain_1 waveform you can rename the waveform,
save it to the PC hard drive, assign it to an AWG channel
for generation, remove it from the SourceXpress waveform
list, change the default waveform properties (recommended
sample rate and amplitude), copy the waveform to a new file

that virtual generator. The Connectivity menu at the top of the

To compile and use a complex IQ waveform, you must use a
Virtual Generator (or a real AWG) with at least two channels.
The user interface will allow you to assign the I component to a
channel and the Q component to a different channel.
In Figure 11 you can see a Run control near the upper left
corner of the waveform display under the Channel label.
• In Continuous run mode, the waveform shown will be
repeated and seamlessly generated continuously with no
gaps while the instrument hardware is in Playing mode
(the green triangular button at the top center). Of course,

Figure 11: Home display of 1 µs pulse width 100 µs PRI radar signal.
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the Play button only has an effect on the AWG output if
SourceXpress is connected over a LAN to a target AWG
or if this was running natively on the AWG itself.

table will be shown in the Home screen so long as the
sequencer is being used to generate a signal.

• In Triggered run mode, the instrument will wait until a
trigger is received, then generate one instance of the
waveform every time it is triggered. The trigger source
can be one of two rear panel connectors on the AWG
(trigger input A or B) or an internal trigger source with a
repetition interval of 1 µs to 10 seconds. In Triggered run
mode the original PRI inherent in the waveform length
is ignored, and the actual PRI will be established by the
external or internal trigger rate. This is useful, since you
can use a short waveform only containing the pulse with
a short PRI interval in the Radar Plug-in, then use the
internal trigger feature (or an externally supplied trigger
signal) to change the generated PRI quickly without
recompiling the waveform.

You can right-click the Waveforms list or Sequences list to

• In Triggered Continuous run mode, the instrument will
wait until a trigger is received, then play the waveform as
in Continuous mode with the PRI set by the length of the
waveform.

Now that the basics of hardware and software have been

• The AWG instruments have two physical buttons on the
front panel which can be used to generate trigger A or
trigger B signals even if no connection is made to the
rear panel trigger inputs. This allows you to generate one
waveform instance each time the appropriate front panel
Force Trigger A or B button is pressed in Triggered mode
or if the sequencer uses trigger events.

EXAMPLE 1: INTRODUCTION TO THE RADAR PLUG-IN

• When using the optional waveform sequencer, the Run
control shown in Figure 11 is not used and a sequencer

Figure 12: Radar Plug-in Pulse Envelope tab view.
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perform actions on these lists, such as removing a particular
file or removing all files. Since waveform files can be very long
and you can include any number of them in the waveform list,
the actual waveforms in the list are stored in Windows virtual
memory, which resides on the disk drive. When you assign
a waveform to a physical AWG output channel and click the
Run button at the top (or load a sequence), the waveforms are
copied from Windows virtual memory into the AWG physical
memory.

Examples
covered, we can review three different examples of generating
radar signals using the AWG70000B and SourceXpress.

Figure 12 shows the power vs time envelope of the RF, IF, or IQ
pulse. You can control details of the pulse envelope, including
shape (such as rectangular, trapezoidial, and raised cosine),
pulse width, risetime, falltime, PRI/PRF (Pulse Repetition
Interval or Pulse Repetition Frequency), droop, overshoot,
ripple percentage, and ripple frequency.

Generating Radar Waveforms with an Arbitrary Waveform Generator
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To use the Radar plug-in, select the Waveform Plug-ins tab

several items) and right-click, you can use the Combine Pulse

in the top menu and then choose RF>radar using the Plug-in:

Group selection to overlap those pulse groups, so they are

selector.

generated simultaneously. For example, you could use the

In the upper right corner of the Radar plug-in you will see a
button to reset the plug-in to default conditions, and Help on
the Radar Plug-in.
Beneath the Plug-in: selector you will see a Signal Format
control.

Modulation and Offsets tabs with different pulse groups to
create a Combined Pulse Group which causes multiple radar
pulses at different frequencies with different modulations to be
simultaneously generated with overlapping start times.
In addition to the Pulse Envelope tab features which affect
the selected Pulse Group, you will see tabs allowing you to

• In RF/IF mode the Radar plug-in will compile a single
real value RF or IF frequency waveform, like what is
shown in Figure 11. Such signals can be generated by a
single channel on any Tektronix AWG70000 or AWG5200
series instrument.

change the modulation, offsets (amplitude, frequency and/or

• In IQ mode the Radar Plug-in will compile a complex
baseband IQ signal. These signals require two channels
of a single AWG such as the AWG70002B or any
AWG5200 series instrument. If you need to create a low
IQ signal at an IF frequency (not strictly baseband), use
the Baseband Offset control while in IQ mode. In the
Home screen, you can open the IQ waveform so the I
and Q components are visible, then either use rightclick>Assign to… or dragging the waveform component
to assign it to an AWG channel.

Pulse Group table to be set to greater than 1), and simulating

The Pulse Train List shows the names of the waveforms which
will be created when the Compile button near the top center
is clicked. You can right-click a pulse train entry to rename
it, which will change the name of the new waveform created
when you compile. You can right-click inside the Pulse Train
List area to add a new pulse train waveform or to import a
pulse train definition from a CSV file. If you click a particular
entry in the Pulse Train List to select it, you will be able to
change the settings for that specific pulse train. A Pulse Train
consists of one or more Pulse Groups from the table at the
right.
To the right of the Pulse Train List is a table showing the
Pulse Groups which will be generated to create the chosen
Pulse Train. The many editing features shown at the bottom
portion of the screen refer to the pulse group index which
is currently selected (highlighted in blue boxes). Use rightclick to add, insert, copy, paste, or remove pulse trains. By
default, the pulse groups are sequentially generated in the
order shown in the table, starting at Index 1. But if you select

phase), staggering the PRI, adding pulse impairments such
as jitter, adding IQ impairments, simulating multipath, adding
interference (bandwidth limited noise), frequency hopping
among multiple pulses (which requires the Repeat count in the
antenna scans. All the entries in these tabs affect the Pulse
Group which is highlighted at the top middle of the screen.
Here is a suggested order of the steps required to set up a
complex radar signal:
1. Choose a waveform name in the Pulse Train List and select
it (making it blue).
2. Select a Pulse Group in the pulse group table, causing it to
have a blue outline.
3. In that index (row in the table), set the Repeat count, Start
Time, and PRI. The Start Time of a Pulse Group is dead
time inserted only before the first pulse in the waveform as
shown in Figure 13. You can also change the PRI or PRF
using the Pulse Envelope tab settings at the bottom.
4. Set any additional Pulse Envelope settings as needed.
The Trapezoidal and Raised Cosine pulse shapes produce
pulsed RF signals with user-controlled rise and fall times
similar to an actual bandwidth limited radar system. You
can view the shape of the pulse envelope at the right. The
full wave rectified RF sinewave waveform peaks will follow
the pulse envelope shown.
5. Move across the tabs from left to right, setting the Modulation, Offsets, Staggered PRI, and other pulse settings
as needed. All the settings in the tabs at the bottom only
affect a particular Pulse Group index which is part of the
selected waveform from the Pulse Train List. Select a different Pulse Group to change its detailed settings, then if
needed select a different Pulse Train List waveform name to
change its Pulse Group details.

multiple pulse groups (by holding the shift key which clicking
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Figure 13: Pulse Group with 2 µs start time inserted before 2 µs wide pulse with 3 µs PRI and a repeat count of three.

6. Be sure that the parameters above the Pulse Group table
are correct. These are global settings which affect all
pulse trains in the pulse train list. For RF/IF Signal Format, Magnitude is the peak output power (defaulting to
the maximum -2.05 dBm), Frequency is the center carrier
frequency of the radar signal, and Coherent Carrier should
be selected if you want the carrier phase of each repeated
pulse group to be coherent from one iteration of the pulse
group to the next. For IQ Signal Format, Amplitude is
the peak output voltage (defaulting to the maximum of
500 mVpp) and Baseband Offset defaults to 0 Hz but can
be set to an offset IF frequency. The Phase Offset setting
rotates the relative phase of the compiled pulse train, which
for example can allow signals simulating a phased array
radar to be separately compiled with different phase offset
settings.
7. If a particular Pulse Group needs to have a different
amplitude, frequency, or phase than the global pulse train
settings just described, select (click) the Index of a particular Pulse Group and at the bottom select the Offsets tab
and change the amplitude, frequency, and/or phase offset
as required. Just as with the other tabs, the Offsets tab
only affects the particular Pulse Group from a Pulse Train
selected at the moment.
8. After all these details are completed, click the Compile
settings gear icon adjacent to the Compile button near
the top center of the screen to open the Compile Settings
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window. In Compile Settings you will find a few more items
which effect the waveforms and sequences produced by
a compilation. The Correction Files area is for use of the
Pre-compensation plug-in. If you want to create a flat single
file without use of the hardware sequencer, be sure to not
check “Create each Pulse Train as sequence”. To instantly
view your results in the Home tab and the AWG output,
select “Compile and assign to channel” and “Play after
assign. If you will be combining waveforms in any way, you
will probably want to set a manual sampling rate so that all
waveforms are compiled at that same rate. In general, the
sampling rate should be at least 2.5 X the RF frequency,
so you should set the sampling rate to at least 25 GS/s to
generate a 10 GHz radar signal. In most cases the radar
waveform fidelity will be best and spurious signals the lowest if the sampling rate is set to the maximum allowed by
the hardware, but you can lower the sampling rate for lower
frequency radar signal generation to reduce the waveform
length, waveform loading time, and in some cases move
aliases and other spurs away from critical frequencies for
the DUT.
9. When you click Compile and if you are not creating a
sequence, each of the names listed in the Pulse Train
List will be separately compiled into similarly named
waveforms. This will create one or more new or overwritten waveforms in the waveform list. Depending on your
compile settings, one of the waveforms may be displayed
on the Home tab.

Generating Radar Waveforms with an Arbitrary Waveform Generator

10. When you click Compile and have chosen to create a
sequence, each of the names listed in the Pulse Train List
will be separately compiled into similarly named sequences
and waveforms. This will create one or more new or overwritten sequences and waveforms in the waveform list.
Depending on your compile settings, one of the sequences
may be displayed on the Home tab.
11. To display a different waveform or sequence in the Home
tab, right-click the waveform or sequence in the Waveforms
or Sequences lists and choose Assign to Channel or use
the selector control adjacent to the channel number in the
upper left portion of the viewing area for the desired channel. You can also drag a waveform (from the Waveforms
list) or sequence (from the Sequences list) into the desired
channel viewing area on the Home tab.

APPLICATION NOTE

16. To clear all files from the Waveforms or Sequences windows, right-click the appropriate file display area and select
Remove All. You will be given the choice to save the waveforms or sequences to a setup file on the PC before they
are removed from the list.
17. To reset the Radar plug-in to default conditions, use the
“Reset Plug-in” button in the upper right of the plug-in.
18. To reset SourceXpress (which resets all settings except
those in the plug-in), use the "Reset to Default Setup"
button, which is the leftmost of the four icons in the upper
right corner of the application.

12. When compiling in sequence mode, a main sequence
(such as “PulseTrain_1”) will be created which will contain a subsequence for each pulse group. Each pulse
group will cause another sequence to be created (such
as “PulseTrain_1-PulseGroup1”) which contains just the
subsequence required to generate that one pulse group. So
in general you want to use the main PulseTrain sequences
(which do not contain “PulseGroup” in their name) to create
13. The main PulseTrain sequence by default contains no wait
for trigger and a Go to First at the end which causes the sequence to repeat indefinitely with no breaks. To change this
behavior, right-click the sequence and choose “Modify Sequence”. The Sequence Editor will open with that sequence
loaded. If you want to generate that pulse train with a 10
ms repetition interval, double-click the step #1 Wait entry
and change it to “Internal”. Then go to Setup>Trigger and
change the Internal Trigger Interval to 10 ms. Now when the
Playing button is active at the top, the pulse train sequence
will be triggered by the internal trigger generator and after
the sequence has completed the sequencer will jump back
to the first step and wait for the next internal trigger. If you
change the Wait source to “TrigA” you will get a pulse train
output every time you press the front panel Force Trigger
A button or a trigger edge is recognized which is applied at
the rear panel Trigger A input.
14.To save the current setup, select the disk icon in the upper
left or use File>Save Setup… to save the complete setup
in the .awgx format which contains the SourceXpress base
software settings, all waveforms in the Waveforms list, and
all sequences in the Sequences list.
15. To recall a previously saved setup, select the folder icon in
the upper left (below File) or use File>Open Setup… to recall a previously saved .awgx file to load the SourceXpress
base settings, load saved waveforms into the Waveforms
list, and load saved sequences into the Sequences list.
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EXAMPLE 2: STAGGERED PRI WITH LFM MODULATION
An example will now be shown of generating a 1 GHz
radar signal with staggered PRI and LFM (linear FM ramp)
modulation. The Pulse Repetition Interval of radar systems is
often staggered (changed in a predictable fashion) to remove
range ambiguity and accidental or purposeful jamming.
Modulating the frequency of the radar signal allows long
pulses to be used to limit the peak power of the transmitter to
reasonable levels while spreading the pulse energy over time
and frequency. The radar receiver uses knowledge of the PRI
stagger and modulation to reduce uncertainty in the range to
the target.
1. Choose the AWG70001B virtual generator. Right-click
it and use Set to Active if it is not already active. If an
AWG70001B is connected to SourceXpress, you could use
it rather than the virtual generator.
2. Click the Reset to Default Setup icon (left-most of the four
icons in the upper right of the screen).
3. In the Setup>General tab, you may want to select “Enable all channels on play” if you are using a live physical
generator. This setting will automatically enable all channels
containing appropriate waveforms to be activated when the
Play button is selected. If this setting is not made, you must
manually enable each channel which is to be used.
4. In the Setup>General tab, select “Apply recommended
settings on assignment”. This setting will apply the hardware settings embedded within a waveform when that
waveform is assigned to a channel. You can see these
recommended settings by right-clicking a waveform in the
waveform list and viewing the properties. Recommended
values for the sample rate, amplitude, and DC offset are
inserted into the waveform properties by a plug-in when
compiling a waveform. If you do not use the recommended
settings automatically, you will need to manually change
these three parameters when playing a waveform.
5. In the Setup>Channel tab, set the Resolution (bits) to
“9+1 Mkr”. This “steals” the least significant bit from the
data driving the DAC and sends that bit to Marker 1. If the
resolution is set to 10 bits you will not be able to use any
markers.
6. In the Waveform Plug-ins tab, select the “RF>radar”
plug-in.
7. Reset the Radar Plug-in using the button in the upper right
of the plug-in.
8. In the Pulse Train List, right-click the default “PulseTrain_1”
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and rename it to “Staggered_LFM”. Set the Frequency to
“1 GHz”.
9. Select Pulse Group Index 1 and set the Repeat count to
“10”.
10. In the Pulse Envelope tab, set the Pulse Shape to “Raised
Cosine”, the Pulse Width to “10 µs”, the Rise Time to “500
ns”, the Fall Time to “200 ns”, and the PRF to “1 kHz”.
Note that the PRI changes to “1 ms” in both the Pulse
Envelope tab at the bottom and the Pulse Group row at the
top. The pulse envelope waveform shows the raise cosine
slow rise and faster fall pulse power profile.
11. In the Modulation tab, set the modulation type to
Frequency>LFM. Set the Sweep Range to “50 MHz” and
the Frequency Sweep to “High to Low”.
12. In the Staggered PRI tab, check the “Turn On” box. Set
the Deviation Type to “Ramp”, the Slope Type to “Up”, and
the slope to “2” Degrees. Note that the Min Deviation is
calculated to be about 34.9 µs. The Staggered PRI tab will
now show a blue indicator showing that this feature is active.
13. Click the Compile Settings gear icon. Disable “Create
each Pulse Train as sequence”. Enable “Overwrite existing
waveform(s)/sequence(s)”, “Compile and assign to channel”, “Play after assign”, and “Auto calculate”. Click Compile at the bottom of the window. The “Staggered_LFM”
waveform should appear in the Waveforms list.
14. Click the Home tab. You should see a display similar to
what is shown in Figure 14.
15. Right-click the Staggered_LFM waveform in the list and
choose Properties. The waveform length is about 75.24 M
points. The recommended sample rate (set by the Radar
Plug-in) is 6.5 GS/s. Click OK.
16. Go to the Setup>Clock tab. You can see that indeed the
AWG clock sample rate is set to 6.5 GS/s due to our earlier
choice at Setup>General “Apply recommended settings on
assignment”. Unless you have changed it, the clock should
be set to Internal.
17. Go back to the Home tab. You can see that we do have the
10 pulses we specified in the radar Plugin Pulse Group #1
Repeat count. The initial PRI visually appears to be 1 ms,
but you can see that by the end of the 10th PRI interval the
waveform length is much longer than (1 ms) * (10) = 10 ms.
Let’s verify the staggers on this screen.
18. Right-click in the middle of the waveform display area and
choose “Show cursors”. You will see two cursors at the
left edge which are labelled 1 and 2 at the bottom. Click
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the mouse on the cursor 1 or 2 handle at the bottom (the
diamond box) or anywhere along a vertical cursor dotted
line and you will see that the mouse cursor changes to a
<-> shape. Click the cursor and drag it to the right near the
center of the screen. Now you can see the two cursors and
can drag each of them independently. The two cursors are
shown at the top as C1 and C2, and their times from the
start of the waveform and the delta time between them are
also shown. You can drag the two cursors to measure the
delta between any two radar pulses and see that the PRI is
increasing across the screen.
19. It’s easy to zoom in and view an individual pulse. In an area
not close to a cursor, click and drag to the right, which will
zoom in to that area. You can do this repeatedly to view
one shaped pulse, the rising or falling edge of a pulse, or
the actual RF voltage waveform. Click and drag to the left
to unzoom. If you click and drag a small distance to the left
you will unzoom back to the full waveform display. If you
click and drag a larger distance (such as half a screen) you
will unzoom by a smaller factor.
20. This waveform is centered at 1 GHz with a 50 MHz high
to low linear FM chirp. You can’t visually see this chirp because the sweep range is only 5% of the center frequency.

Figure 14: Staggered PRI full waveform view.
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The marker is enabled because we changed the
Setup>Channel>Resolution to “9+1 Mkr”, and by default the
Radar Plug-in sets it to a 50% duty cycle. We can move it to
coincide with the “on” time of the third pulse as follows:
21. Right-click the Staggered_LFM waveform name in the
waveform list and select Modify Markers. You should now
be in the Modify Waveform pop-up window Pattern tab.
22. Set the Pattern Type to “Low”. In the Apply Modifications
To area select only “Marker 1” and deselect other choices.
Set the Range to All Samples. At the bottom, select Create New Waveform then click Compile. You should see
a new “Staggered_LFM_1” waveform in the waveform list
and the Modify Waveform pop-up with M1 set to all zeros.
23. Set the Pattern Type to “High”. And the Range to “Between
Cursors”. As described earlier, zoom in to the third pulse
by dragging the mouse (with the left button held down) to
the right across the third pulse so that it’s zoomed out to
at least half of the display width. You can click and drag
to the left to unzoom. This might require several zoom/unzoom steps. Then move cursor 1 to the left rising edge of
the pulse and cursor 2 to the falling edge. You can change
the horizontal scale of these displays to time or sample
points by right-clicking the display black background and
choosing X Axis > Seconds or Samples. On my display

my choice results in a delta C between the cursors of about
10.4 µs or 67.6 k samples.
24. At the bottom, select Overwrite Waveform then click
Compile. The “Staggered_LFM_1” waveform should be
overwritten with marker M1 set high only around the third
pulse. Click Close.
25. Drag the new “Staggered_LFM_1” waveform from the
waveform list to the Home screen waveform area. You
should see a single M1 marker pulse at the third pulse
on time. If you zoom into that third pulse, you should see
something similar to Figure 15. Note that since we set the
Raised Cosine pulse shape with a 500 ns rise and 200 ns
fall, the rising and falling edges are not symmetrical. You
could use the Marker 1 pulse to trigger an oscilloscope
only on that third pulse, to apply a gating pulse to circuitry
in your radar transmitter or receiver.
26. If you save the setup as “Example 2.awgx”, you can recall
both the original and modified marker waveforms, Radar
Plug-in settings we made, and the SourceXpress miscellaneous changes we made at a later time.

Figure 15: Third staggered PRI pulse RF voltage waveform and modified Marker 1 zoom view. Note that the marker has
been moved in time to coincide with the third RF pulse.
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EXAMPLE 3: BASEBAND IQ GENERATION WITH AND WITHOUT
SEQUENCING
This example will show how to generate an IQ baseband
radar signal with stepped frequency modulation and various
impairment for testing a receiver.
1. Choose the AWG70002B virtual generator. Right-click it
and use Set to Active if it is not already active.
2. Click the Reset to Default Setup icon (left-most of the four
icons in the upper right of the screen).
3. In the Setup>General tab, select both “Enable all channels
on play” and “Apply recommended settings on assignment”.
4. In the Setup>Channel tab, select Channel 1 and set the
Resolution (bits) to “9+1 Mkr”. Then select Channel 2 and
set the Resolution (bits) to “10+0 Mkr”.
5. In the Waveform Plug-ins tab, select the “RF>Radar”
plug-in.
6. Reset the Radar Plug-in using the button in the upper right
of the plug-in.
7. Set the Signal Format to “IQ” in the upper left corner of
the plug-in.
8. In the Pulse Train List, right-click the default “PulseTrain_1”
and rename it to “IQ_step_FM”. Note that you could set
a Baseband Offset if you needed to generate an IQ signal
with two channels at an IF frequency.
9. Select Pulse Group Index #1 and set the Repeat count to
“1”. In the Pulse Envelope tab, set the Pulse Shape to
“Raised Cosine”, the Pulse Width to “50 µs”, the Rise Time
to “1 µs”, the Fall Time to “1 µs”, and the PRF to “1 kHz”.
Note that the PRI changes to “1 ms” in both the Pulse
Envelope tab at the bottom and the Pulse Group row at
the top. In the Modulation tab, set the Modulation type to
“Frequency>Step Frequency”. Set the Step Count to “4”,
the Initial Offset to “10 MHz”, the Frequency Offset to “10
MHz”, the Ramp Function to “Cosine”, and the Ramp Duration to “10%”.
10. Now double click the Pulse Group index #2 Type field and
choose “Pulse Group” in the pop-up. Leave the Repeat
count set to “1”. While that second pulse group is highlighted, in the Pulse Envelope tab at the bottom set the
Pulse Shape to “Trapezoidal”, the Rise Time and Fall Time
to “10 µs”, the Pulse Width to “100 µs”, and the PRF to
“2 kHz”. In the Modulation tab, set the Modulation to
“Frequency>Up-Down Chirp”. Set the Sweep Range to “10
MHz” and the Up-Down Count to “1”.
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11. Click the Compile Settings gear icon. Disable “Create
each Pulse Train as sequence”. Enable “Overwrite existing waveform(s)/sequence(s)”, “Compile and assign to
channel”, “Play after assign”, and “Auto calculate”. Click
Compile at the bottom of the window. You should see one
new waveform named “IQ_step_FM”.
12. In the Home tab, you should see the I component in the
Channel 1 window and the Q component in the Channel 1 window. Click the up/down icon adjacent to the
“IQ_step_FM” waveform in the waveform list to view the
I and Q component labels. You can right-click I or Q and
then save that signal component waveform or assign it to
an AWG channel. Due to Signal Format being set to “IQ”
in the Radar plug-in, the I and Q waveforms were automatically assigned to the two channels after compilation. If you
zoom into the first pulse group and then the second pulse
group you can see the step FM and linear up/down chirp
FM modulation.
13. Marker 1 on Channel 1 is by default active in the first 50%
of the first pulse group only. In the Channel 1 waveform
selector at the top of the waveform display window, select
Modify Markers. Choose to Apply Modification to “Marker 1
only”, set the Range to “All Samples”, set the Pattern Type
to “Pulse”, set the Start Level to “Low”, set High Steps to
“20 Samples”, set Low Steps to “20 samples”, set “Create
New Waveform”, and click Compile. Then click Close.
14. Open the IQ selector on the “IQ_step_FM_1” new waveform in the waveform list. Right-click I and assign it to
Channel 1, and in a similar fashion assign Q to Channel
2. Right-click the black waveform background and Show
Cursors, then set the X axis to Seconds. Zoom in so you
can see the Channel 1 Marker 1 spread out and use the
cursors to measure the period. It should be 100 ns, since
we set the marker waveform to 20 samples high and 20
samples low, and in the Setup>Clock menu you can see
that the Sample Rate was automatically set to 400 MHz.
So the Marker 1 frequency is 400 MHz / 40 samples = 10
MHz, a 100 ns period. This clock signal provided by Marker
1 is phase synchronized to the signal RF waveform and
modulation, and could be used to provide a clock input for
a receiver DUT.
15. See the result in Figure 16. Save this example as “Example
3 flat.awgx”, since it is a “flat” single non-sequenced
waveform file.
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Figure 16: Baseband IQ example flat single waveform with zoom showing Marker 1 (10 MHz clock output).

16. Now let’s see what happens if we compile the same signal
as a sequence. To compile a signal which makes use of
the sequencer, either an AWG with the sequencer option
installed must be connected or a Virtual Generator with
Option 03 – Sequencing checked must be active.
17. Right-click both the Sequences and Waveforms windows
and remove all files. Then select the Waveform Plug-ins tab
and enable “Create each Pulse Train as a sequence”, then
click Compile and Close.
18. Four waveforms should appear in the Waveforms list and
three sequences in the Sequences list.
19. The waveforms are:
a. Pulse Group #1: pulsed step frequency step modulated
IQ baseband waveform
b. Pulse Group #1: zero volt short waveform which is
repeated to generate the off time
c. Pulse Group #2: pulsed up-down frequency chirp
modulated IQ baseband waveform
d. Pulse Group #2: zero volt short waveform which is
repeated to generate the off time
20. The sequences are:

22 | WWW.TEK.COM

a. IQ_step_FM: The main sequence which generates the
baseband IQ signals
b. IQ_step_FM-PulseGroup1: The subsequence required
to generate the first pulse group (FM step modulated)
c. IQ_step_FM-PulseGroup2: The subsequence required
to generate the second pulse group (up-down
frequency chirp modulated)
21. We can look at the main sequence in the Sequence Editor
and modify it. Right-click the “IQ_step_FM” sequence and
select “Modify Sequence”. Then open the Sequencer Editor
tab.
22. If you double-click the triangle adjacent to the step 1 and
step 2 index, you can see the subsequences, which consist
of the IQ modulated waveform followed by a repeated short
off zero volt waveform. Click the large X at the right to close
the subsequence display.
23. The automatically generated sequence will immediately
start when you enable Play and will then play one instance
of pulse group #1, followed by one instance of pulse group
#2. This could be changed in the pulse group definition, but
we can also make changes quickly in the Sequence Editor
and add some triggering and flag output features.
24. In sequence step #1, change Wait to “Internal”. Change the
Repeat Count to “8”. Then double-click the icon to open
the subsequence, and change Flag A to “Toggle” (which
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displays as “T”). Then click X to close the subsequence
display.
25. Then select Sequence Settings and enable “Flag Repeat”.
This will cause the flag A toggling to occur every time that
sequence step #1 is repeated. Since the repeat count is
8, this should cause the flag A output to produce 4 output
pulses during the repeating pulse group #1 time.
26. Go to the Setup>Trigger tab and change the Internal Trigger Interval to “100 ms”. Now the following will happen 10
times per second:
a. The pulse group 1 IQ baseband waveform will be
output, lasting 8 ms per iteration. It will be repeated 8
times. The Flag A output will be set high on iterations
1, 3, 5, and 7, and will be set low for iterations 2, 4, 6,
and 8.
b. The pulse group 2 IQ baseband waveform will be
output 1 time, lasting 500 µs.
c. The sequencer then jumps to the first step and waits
for the next trigger.
27. The resulting sequence and subsequence should look like:
a. Figure 17 - Baseband IQ example main sequence
b. Figure 18 - Baseband IQ example subsequence
showing flags
c. Save this example as “Example 3 seq.awgx”, since it
uses the sequencer.

Figure 17: Baseband IQ example main sequence.
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Figure 18: Baseband IQ example subsequence showing flags.

Conclusion

Further Reading

The Tektronix AWG70000B instrument can generate high-

Radar Signal Generation with a High-Performance AWG

quality radar signals thanks to its advanced 10-bit SiGe DAC

provides background information on radar signal modulation

with low spurious output, a low phase noise architecture

and high quality test signal generation using AWG direct

allowing use with golden external microwave clocks, and a

synthesis.

high-performance real-time hardware waveform sequencer.
Options offer a wide range of output power and tightly
synchronized multi-channel operation for a wide range of
scenarios. SourceXpress software provides control of the
instrument and local or offline generation of advanced radar
test signals with the ability to correct for signal flatness due to
test cable and other causes. These features together provide a
robust platform for simple definition and generation of not only
complex radar signals, but any RF or time domain waveform.
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Using the Sequencer on Tektronix AWG70000B Series
Instruments provides more detailed information on the
hardware sequencer option.
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Appendix A: Additional Features
ADDITIONAL RADAR PLUG-IN FEATURES
The Radar Plug-in includes a number of other features not
addressed in the examples in this document. Here are features
which can be chosen for each pulse group independently:
• Modulation types:
o CW (Continuous Wave, i.e. unmodulated)
o Frequency modulation: Linear FM (LFM), Chirp
Sequence, Up-Down Chirp, Piecewise linear LFM, Step
frequency, user defined step FM/AM, and non linear
FM (Taylor weighted symmetrical, Taylor weighted nonsymmetrical, user defined FM polynomial coefficients)
o Phase modulation (Barker Code, Frank Code,
Polyphase Codes, P1 Polyphase Codes, P2 Polyphase
Codes, P3 Polyphase Codes, P4 Polyphase Codes,
user defined step PM/AM)

S-PARAMETER PLUG-IN SUPPORT
If the S-Parameter license is installed, the Radar Plug-in can
use imported Touchstone S-Parameter files to embed or
de-embed external networks between the AWG output and
the DUT. Either a single (non-cascading) or multiple (up to 6
cascading) S-Parameter files can be used to precompensate
generated radar signals. This feature can correct for known
cable losses, filters, antenna S-Parameters, and other existing
or simulated non-existing hardware.
ENVIRONMENT PLUG-IN SUPPORT
The Environment plug-in gives you an additional screen in
SourceXpress which allows multiple RF signals to be simulated
and digitally combined into an output waveform which can
produce an effect similar to a real-world environment. Emitter
types include:

o Digital modulation (BPSK, QPSK) on pulse

• Analog modulation (AM, FM, PM)

o Custom IQ modulation (import of text or MATLAB
generated IQ file)

• Bluetooth (LE 1M, LE 2M, LE Coded, BR, EDR)
• CDMA forward and reverse links

• Offsets (Amplitude, Frequency, and Phase): Each pulse
group can have a different offset. If the pulse group is
repeated, either a linearly changing offset per step or a
user-defined varying offset per step can be used.

• Digital Modulation (many PSK types including QPSK/
BPSK/SOQPSK/etc., APSK, QAM, FSK, CPM, ASK,
GMSK, OOK)

• Staggered PRI (Pulse Repetition Interval): The PRI can be
staggered using a deviation list (linear ramp, values from
a table, or values from a file).

• GSM

• Edge and width jitter impairment with a Gaussian or
Uniform distribution and user selected deviation
• IQ Impairments: Swap I & Q, add carrier leakage, invert
I and/or Q signal, quadrature phase error, IQ amplitude
imbalance

• DVB-T
• LTE
• Noise (while and band limited)
• OFDM
• P25 phase 1 and phase 2
• Basic RF pulses

• Fixed MultiPath impairment: Up to 10 paths with settable
delay, amplitude, and phase

• Radar features from the Radar Plug-in

• Additive noise with selectable S/N ratio and bandwidth.
This noise can be applied to the whole signal or only to
the pulse on time

• User imported waveforms

• Frequency Hopping (Custom, Pseudo Random over a
specified range, Pseudo Random over a frequency hop
list
• Antenna scan: Either a custom scan using amplitude
values from a file, or a simulated circular scan assuming
a Gaussian or Sin(x)/x beam profile

• Tones (multiple carriers)
• W-CDMA
• WiFi (802.11a/b/g)
• WiMax
Up to 50 scenarios can be built. Each scenario can contain up
to 100 emitters. The frequency and duration of each emitter
can be specified.
PRE-COMPENSATION PLUG-IN SUPPORT
The Pre-compensation plug-in allows you to flatten the
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or base patterns. Transmitter and channel impairments
may be added, and jitter can be included.

amplitude and phase response over frequency of the AWG,
including a test cable. The measurement plane is the far end
of that cable, which is connected to a wideband Tektronix
oscilloscope during the test. The Pre-Compensation plug-in

ADDITIONAL AWG70000B HARDWARE FEATURES

automatically generates an RF frequency wideband signal

Pattern jump: This is a parallel 8-bit digital input with strobe

which is measured by the oscilloscope, and a S-parameter

signal which forces the sequencer to jump to one of 256

correction file is created which can be used to pre-compensate

predefined sequence steps.

any signal generated by the Radar plug-in. This feature enables
wideband radar signals to be generated with flat amplitude and

Skew: The timing skew between the marker outputs and the

phase response at the end of the test cable.

two analog waveforms on the AWG70002B two-channel model
can be adjusted with 1 ps or better resolution.

ADDITIONAL SOURCEXPRESS FEATURES

Marker amplitude: The marker outputs can be set to generate

Besides the Radar plug-in, SourceXpress has many other

500 mV to 1400 mV P-P over a range of -1400 mV to +1400

features that may be useful for engineers working with radar

mV.

systems.
External sampling clock support: The AWG70000B instruments
Base features:
• The Capture/Playback feature allows IQ files to be
digitally upconverted to an output frequency. A list of
such signals can be provided, and they will be converted
and concatenated in time.

have a low phase noise internal clock synthesizer. But in some
cases even lower phase noise is required. A 6.25 to 12.5 GHz
external golden clock can be supplied to a rear panel input on
the AWG70000B instruments. This allow state-of-the-art low
phase noise to be achieved for generating radar signals. The

• The AWG can be used as a function generator using
SourceXpress features.

AWGSYNC01 synchronization hub can distribute this golden

• Equation Editor: This feature lets you create waveforms
from equations and combine waveforms.

instruments for very low phase noise multichannel radar test

low phase noise clock signal among up to 4 AWG70000B
signal generation.

• Table editor: Waveforms and markers can be viewed and
edited on a point by point basis.

Signal quality: The AWG70000 single-channel series has

• Batch CSV file import: Allows simple waveforms and
sequences to be externally defined.

signal requirements in the US, including use of the option AC

Optional features:
• RF generic plug-in option: This feature can generate a
wide range of digitally modulated signals, including multicarrier signals.
• OFDM plug-in option: OFDM signal generation, mainly
based on 802.11a WiFi and 802.16 WiMax
• Multitone plug-in option: This feature creates a grid of
carriers or a frequency chirp.
• Optical plug-in option: This is used to generate
waveforms suitable for modulating single or dual
polarization optical communication signals.
• High speed serial data signal creation plug-in option: This
is used to generate commonly used serial signal formats
including NRZ, NRZ-I, and PAM with the ability to add
scrambling, controllable risetime and falltime, and duty
cycle distortion. Markers can be used to generate clocks
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been certified to meet SEI (specific emitter identification) test
amplifier/attenuator. (See Figure 19.)
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Figure 19: Option AC amplifiers and filters.

Appendix B: AWG70000B Hardware Block
Diagram

word pulled from memory can be sent to the Marker 1 and

The AWG70000B Series has an internal Windows® 10 PC

clocked on both the rising and falling edges of the external

for running software without any external equipment. The

clock. Since the maximum sample rate for each DAC is

internal display screen isn’t very large due to the small size of

25 GS/s, the maximum high speed clock frequency is

the instrument, so it is suggested that an external display be

12.5 GHz, and it can be supplied by an internal frequency

used if creating waveforms or sequences using the standard

synthesizer or an external 6.25 to 12.5 GHz clock input. A

instrument software as shown in Figure 2. The SourceXpress

binary divider inside the DAC subsystem generates lower

software features are easier to use for significant projects on a

sample rates.

recent Windows 10 PC as shown in the remote use models:

Marker 2 front panel digital outputs. A high speed clock at
half the sample rate is sent to the DAC subsystem, which is

On the AWG70002B two channel 25 GS/s maximum sample

• Figure 3 - Independent PC remote use model

rate model, each DAC subsystem differential output is directly

• Figure 4 - Connected remote use model

connected to the DC coupled front panel output connectors.

• Figure 5 - Synchronization hub use model

On the AWG70001B one channel 50 GS/s maximum sample
rate model, the two DAC subsystem outputs are summed and

The AWG70001B and AWG70002B instruments each have two

sent to the DC coupled single differential output channel, and

10-bit 25 GS/s DAC subsystems which convert 10 bits of data

the clocks to the two DAC subsystems are skewed by 180

from an internal high speed memory word into a differential

degrees (half a clock cycle). The result is an interleaved single

analog voltage. Zero, one, or two bits of the 10 bit memory

output at 50 GS/s maximum sampling rate.
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Option AC is only available at purchase of the AWG70001B

end of the waveform the instrument can stop, seamlessly

model. The normal two output connectors are still present

loop back to start playing from the starting point of that same

for a DC coupled differential output. An internal mechanical

waveform, or seamlessly start playing out a different waveform.

microwave relay disconnects these connectors and routes the

The hardware waveform sequencer controls how the memory

interleaved DAC outputs through a wideband balun to a series

is read out, and it also controls the hardware output flags. Two

of filters and amplifiers providing around +18 to +25 dBm

external trigger inputs and a programmable internal trigger

maximum output power from 10 MHz to 18 GHz through a

rate generator provide additional control over the hardware

single AC coupled front panel output. Lower output levels can

sequencer.

be set using internal step attenuators as shown in Figure 19.

A basic block diagram of the AWG70001B with option AC is

Waveform data from the high-speed memory is read into

shown in Figure 20.

the DAC subsystems and the DAC is clocked at the chosen
sampling rate. By default, the memory is sequentially read from
the first to the last point of the chosen waveform. Depending
on the settings and use of the hardware sequencer, at the

Internal
PC

SSD

LAN

Hardware
Memory
Sequencer

External
User PC
SourceXpress

Ext
Clock
Inputs

High-Speed
Clock Synthesizer

CLK
10-Bit DAC

optional

Ext
Trigger
Inputs

High-Speed
RAM

CLK
10-Bit DAC

Differential
Output
DC Coupled x2
Option AC
Amp/Filter

AC
Coupled
x1

Marker 1 out
Marker 2 out

Figure 20: AWG70001B + option AC block diagram.

+
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Contact Information:
Australia* 1 800 709 465
Austria 00800 2255 4835
Balkans, Israel, South Africa and other ISE Countries +41 52 675 3777
Belgium* 00800 2255 4835
Brazil +55 (11) 3759 7627
Canada 1 800 833 9200
Central East Europe / Baltics +41 52 675 3777
Central Europe / Greece +41 52 675 3777
Denmark +45 80 88 1401
Finland +41 52 675 3777
France* 00800 2255 4835
Germany* 00800 2255 4835
Hong Kong 400 820 5835
India 000 800 650 1835
Indonesia 007 803 601 5249
Italy 00800 2255 4835
Japan 81 (3) 6714 3010
Luxembourg +41 52 675 3777
Malaysia 1 800 22 55835
Mexico, Central/South America and Caribbean 52 (55) 56 04 50 90
Middle East, Asia, and North Africa +41 52 675 3777
The Netherlands* 00800 2255 4835
New Zealand 0800 800 238
Norway 800 16098
People’s Republic of China 400 820 5835
Philippines 1 800 1601 0077
Poland +41 52 675 3777
Portugal 80 08 12370
Republic of Korea +82 2 6917 5000
Russia / CIS +7 (495) 6647564
Singapore 800 6011 473
South Africa +41 52 675 3777
Spain* 00800 2255 4835
Sweden* 00800 2255 4835
Switzerland* 00800 2255 4835
Taiwan 886 (2) 2656 6688
Thailand 1 800 011 931
United Kingdom / Ireland* 00800 2255 4835
USA 1 800 833 9200
Vietnam 12060128
* European toll-free number. If not
accessible, call: +41 52 675 3777
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